
Welcome
Welcome to Barking Cards Lite---the quickest way to create and send zany animated greetings.      With this 
product, you'll be able to:

· Personalize your card with your own messages, recordings, pictures, clip art - you name it!
· Save it as a small, auto-playing file    
· And send it via e-mail or by diskette.

The best part is that you'll be able to do all this in less than 10 minutes (including sending) from the comfort 
of your own home.    And your friends and family will love the cards--we guarantee it!

Barking Cards Lite is one of the only products available that was designed from the start to produce high 
quality, multimedia greetings card that can be sent easily via e-mail.    

All of our cards offer:
· High quality animation, music and sound (not just static pictures)
· "E-mailable" size:    Optimized animation player, graphics and compression so cards can easily be sent 

over e-mail and by modem
· Unlimited use---unlike printed cards that you buy in the store, Barking Cards can be uniquely 

personalized and sent over and over again.

We know you'll be thrilled with the cards that you can create using Barking Cards Lite.      And there will 
always be more cards on the way    (check out the additional cards on our Barking Cards 96 CD-ROM)

So without further adieu...let's get on with the fun!



Trademark and Licensing Information
© 1995-1997    Blaze Technologies, Inc. All Rights Reserved.
PO Box 4480, Mountain View, CA 94040-4480

This documentation may not, in whole or in part, be copied, translated or reduced to any electronic form 
without prior written consent from Blaze Technologies, Inc.

Barking Cards 96, Barking Cards Lite and Barking Cards are trademarks of Blaze Technologies, Inc.    All 
other trademarks in this manual are the sole property of their respective owners.

Software License Agreement
1. NOTICE: THIS SOFTWARE IS BEING LICENSED TO YOU ON THE CONDITION THAT YOU ACCEPT ALL OF THE 
TERMS CONTAINED IN THIS LICENSE AGREEMENT (this "Agreement").    PLEASE READ THE LICENSE 
AGREEMENT CAREFULLY BEFORE INSTALLING OR USING THE SOFTWARE.    BY INSTALLING OR USING THE 
SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THE LICENSE AGREEMENT.    IF YOU DO NOT AGREE 
TO THESE TERMS THEN BLAZE TECHNOLOGIES, INC. ("Blaze")    IS UNWILLING TO LICENSE THE SOFTWARE 
TO YOU AND YOU SHOULD NOT INSTALL OR USE THE SOFTWARE.    IN SUCH CASE, IF YOU PAID FOR A LICENSE
TO THE SOFTWARE, THEN RETURN THE UNINSTALLED SOFTWARE AND ALL OTHER MATERIAL IN THIS 
PACKAGE ALONG WITH PROOF OF PAYMENT WITHIN 30 DAYS TO THE AUTHORIZED DEALER FROM WHOM 
YOU OBTAINED IT FOR A FULL REFUND OF THE PRICE YOU PAID.

This Agreement has 3 Sections.    Section I applies if you have purchased a license to the accompanying software (the "Software").    
Section II applies if you are evaluating the Software and have not purchased a license to the Software.    Section III applies to all users.

SECTION I - TERMS FOR USE BY PURCHASERS OF THE SOFTWARE

Grant:     If you have purchased a license to the Software,    Blaze grants you a license to install and use the Software in accordance with 
the Permitted and Restricted Uses outlined in Section III.        

Limited Warranty: Blaze makes the following sole warranty:
The media on which the Software is stored (if provided by Blaze)    will be free from defects in materials and workmanship under normal
use for a period of ninety (90) days from the date you purchased a license for the Software as evidenced on your proof of purchase.    If 
the media fails to conform to this warranty, Blaze may at its sole discretion:    (1) replace any media that you return during the warranty 
period or (2) provide you with a refund of your purchase price.    

WARRANTY DISCLAIMER:
BLAZE DOES NOT WARRANT THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT ITS 
OPERATION WILL BE UNINTERRUPTED OR ERROR-FREE.    BLAZE    EXCLUDES AND EXPRESSLY DISCLAIMS 
ALL EXPRESS AND IMPLIED WARRANTIES NOT STATED HEREIN, INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.    This limited 
warranty gives you specific legal rights, and you may also have other legal rights, which vary from state to state.

SECTION II - TERMS FOR USE IN EVALUATION OF THE SOFTWARE

GRANT: Blaze grants you a license to install and use the Software free of charge for 30 days in order to evaluate the Software.      The 
Permitted and Restricted Uses of the Software are outlined in Section III.      If you are evaluating the Software in this manner, you are 
not entitled to technical support or telephone assistance.

DISCLAIMER OF WARRANTY: THE SOFTWARE PROVIDED FOR EVALUATION PURPOSES IS PROVIDED "AS IS" 
WITHOUT WARRANTY OF ANY KIND.      IF THE SOFTWARE IS DEFECTIVE, YOU AND NOT BLAZE MUST PAY FOR 
ANY COST OF SERVICE OR REPAIR.

Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.    This limited 
warranty gives you specific legal rights, and you may also have other legal rights, which vary from state to state.

SECTION III - TERMS FOR ALL USERS OF THE SOFTWARE 

Ownership and License.  This is a license agreement and NOT an agreement for sale.    Blaze continues to own the copy of the 
Software and all other copies that you are authorized by this Agreement to make. The Software is protected by copyright law. Your rights



to use the Software are specified in this Agreement, and Blaze retains all rights not expressly granted to you in this Agreement.    Nothing
in this Agreement constitutes a waiver of Blaze's rights under US Copyright law or any other federal or state law.

Permitted Uses:  You are granted the following rights to the Software:
· You may install and use one copy of the Software on a single computer.
· You may make one copy of the Software for backup purposes.      You may not copy the documentation.
· You may transfer the Software on a permanent basis if and only if you: (1) transfer all copies of    the Software on all media types, 

including but not limited to hard disks, floppy disks, CD-ROMs; (2)    transfer all documentation; AND (3) the recipient agrees to 
the terms of this Agreement. If this is an upgrade version, you must transfer all previous versions as well.    Furthermore, such 
transfer terminates your license for the use of the Software.

· You may make and distribute an unlimited number of copies of individual, "self executing    cards" that you develop with the 
enclosed program if and only if you:    (1) do not sell, license or rent your self executing cards for profit; AND (2) do not in any 
way alter the screen that displays the notice "© 1995-1997    Blaze Technologies, Inc. All Rights Reserved."

Restricted Uses:  You may not:
· Rent, sublicense or lease the Software.
· Modify, translate, reverse engineer, decompile or disassemble the Software.

LIMITATION OF LIABILITY
BLAZE SHALL IN NO EVENT BE LIABLE TO YOU FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES EVEN IF BLAZE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.    
BLAZE'S LIABILITY TO YOU SHALL NOT, UNDER ANY LEGAL THEORY,    EXCEED YOUR PURCHASE PRICE OF 
THE SOFTWARE.

Some sates do not allow these limitations or exclusions, so they may not apply to you.

Untied States Government Restricted Rights.  The Software and documentation are provided with Restricted Rights.    Use, 
duplication or disclosure by the US Government or any agency or instrumentality thereof is subject to restrictions as set forth in 
subparagraph (c)(1)(ii) of the of the Rights in Technical Data and Computer Software clause at    DFARS 252.227-7013, or in 
subdivision (c) (1) and (2) of the Commercial Computer Software - Restricted Rights Clause at FAR 52.227-19, as applicable.    
Contractor/Manufacturer is Blaze Technologies, Inc., P.O. Box 4480, Mountain View, CA    94040-4480. 

Miscellaneous Provisions:    This Agreement will be governed by laws of the State of California.    No change or modification of this 
Agreement will be valid unless it is in writing and is signed by both you and Blaze.    If you have any questions regarding this 
Agreement, write to us at Blaze Technologies, Inc., P.O. Box 4480, Mountain View, CA    94040-4480.



System Requirements
Before you start the installation, you should check that your system meets the following minimum 
requirements:

· 486 (or higher) IBM PC compatible running the Windows 95 operating system
· 8 MB of RAM
· 12 MB of available disk space
· VGA or higher Video board
· CD-ROM drive
· Mouse 

Optional Equipment (but recommended)
· Sound card
· Modem to send greetings on line
· Scanner to scan photos or art

The recipients of the cards that you create will need the following minimum configuration:

· 486DX (or higher) IBM PC compatible running the either the Windows 3.1 or Windows 95 operating 
system

· 8 MB of RAM
· 5 MB of available disk space
· VGA or higher Video board
· Sound card (if you want them to hear the sounds in the cards)



Barking Cards 96 Cards
If you find that you enjoy our Barking Cards Lite product, you may want to purhcase the complete version on
CD-ROM, Barking Cards 96.    It includes 25 animations which are described below by category.    Here's 
how you order:.      

Birthday
Candles       
Two crazy characters resort to a candle machine gun to fill a cake with far too many candles.      Then the 
cake is appropriately ignited with a flame thrower. Punchline: Is this what they meant by...1000 points of 
light?
 
Birthday Striptease (for a man)
Raucous music plays as the delectable Lolita proceeds to disrobe in a very sexy manner.      As she is poised 
for to take off that final strip of clothing, a Windows like message appears stating, "Your hard disk has been 
corrupted...Try again later"
 
Birthday Striptease (for a Woman)
Raucous music plays as a sexy construction working hunk proceeds to disrobe in a very provocative manner. 
As he is poised for the final action of    unzipping his skin tight jeans a Windows like message appears 
stating, "Your equipment has overheated...Try again later"

Clinton and Fast Food
A scene shows the secret service staking out a Mega Burger fast food establishment.    Inside, Bill Clinton is 
eating his fair share of 
hamburgers and fries.    In between Mega Bites he manages to convey his Birthday message which is to give 
you a 21 bin salute. 
Wishing Well      
 A    kooky character stands at a wishing well.    He tosses a coin at the well, but it bounces harmlessly in the 
grass.    
in his second attempt a bird swoops down from the sky to grab the coin. Finally he reaches into his pocket for
his 
foolproof credit card, tosses it in the well and a flaming birthday cake pops out. 
 
Balloon Man Birthday
Reginald is happily pumping up a sign that reads "Happy Birthday".    A mischievous cat appears and sticks 
the pump 
cord into the his trousers instead.    Reginald continues to inflate himself and floats off into the sunset in a 
Monty 
Pythonesque manner and the verse appears.    Punchline: Here's a little advice...Don't let a little old birthday 
get you 
blown out of proportion!
 
Boy’s Basketball Wish
As a boy sits patiently at a table, a caption appears, "Hoping your birthday wishes come true".    A thought 
bubble appears with
him at the foul line with 1 second left in a basketball game.    He successfully tosses in the winning free throw
which is his 
birthday wish.
 
Girl's Mall Wish
As a girl sits patiently at a table, a caption appears, "Hoping your birthday wishes come true".    A thought 
bubble appears with 
her standing in front of a giant mall as she pulls out a handful of cold, green cash which is her birthday wish
 



Dentist
A boy is sitting in a dentist's chair for an examination.    A message flashes "It could be worse...".    The 
dentist proceeds through the 
examination discarding wacky equipment such as a hatchet and pliers.    This scene ends    with the dentist 
feverishly drilling while the boy squirms in pain and the punchline is revealed "you could be having a 
birthday AND a root canal".    Finally the    scene changes and "Happy Birthday" has been carved in the boys 
teeth
 
Morbid Birthday
The card is a wacky, Generation X card.    A ghoulish group is gathered around a table as the birthday 
character is celebrating his birthday haul.      The screen reads: "Enjoy your newly acquired materialistic 
possessions now..."        Suddenly the shadow of the grim reaper and the punchline "for inevitably...You’re 
going to die"
 
SuperComputer (Belated Birthday)
A mainframe computer geek is asleep on the job.    Suddenly a major error occurs and he leaps into action to 
save the day.    After trying 
various moves a catastrophe is averted.      Punchline:    "Sorry I missed your birthday...I guess I need to 
upgrade my memory"

Holiday
    
Elephant on a roof
An elephant climbs a ladder and stumbles onto a roof.        He gets back to his feet and plugs in a sign that is 
sitting atop the roof.    
The sign flickers until he gives it a healthy whack and a    "Happy Holidays" message is illuminated
 
Elephant sneeze
An elephant is trimming a Christmas tree.      Suddenly he sneezes and the entire tree is blown away.    The 
tree is miraculously restored 
and the message appears "Enjoy the Magic of the Holiday Season".

Romance and Friendship
    
Can't get you outta my mind
For the woman in your life:    A man's face appears on screen with a beautiful woman inside his eyes.    She 
strolls playfully through his 
head and then recites "He loves me, He loves me not" as she picks petals off a flower.    She blows a final kiss
to the viewer and the 
punchline "I can’t get you outta my mind" appears. 

Call Me
A woman is standing before a box.    She sarcastically says, "It doesn't bother me at all that you don't call", 
reaches into the box 
and pulls out a monster.      As the monster snarls and drools, she mild-manneredly says "I just know that 
you'll love this...Wish I was 
there to see the look on your face."
 
Princess and the Frogs
A beautiful princess floats onto the screen.    As a frog jumps by, she gets a wonderful idea.    She proceeds to 
catch frogs in the air
and kisses them to try to find her prince.    Finally a frog turns into prince.    Punchline:    "I'm so glad I didn't 
toss you back!" or "Thanks
for turning out to be my prince"
 



Romance in the Art Gallery
A woman wanders through a funky art gallery to the sounds of bohemian background music.    She stops 
before a painting of a man at a table as the painting comes to life.    A hand extends from the painting and 
invites her in.    She steps into the painting to join her magical mate for a drink.    Punchline: "Thanks for 
bringing magic into my life!"

Thank You
    
Bug Thank You
An annoying bug dances on stage singing "Thank you, thank you, thank you".    A classic hook grabs him, 
drags him off stage. Punchline: "I didn't mean to bug you but I wanted to say THANKS!"
 
Lifesaver
A man in a life raft is floating in the ocean when sharks begin circling the raft (with ominous music playing 
in the background).    
Just as it looks like curtains for our hero, a submarine lifts the raft out of the ocean, saves the day.    
Punchline:    "Thanks for being
 there when I need you"
 
Mime Thank you
A mime moonwalks onto the screen to sweet piano music in the background.    He turns, produces a bouquet 
of flowers and tosses them to the viewer.    The scenes changes to reveal the verse "Words were just not 
enough to say thanks!" amidst a shower of soft petals falling to the ground

Congratulations
    
Devil of a Job
The view is of a boss on the other side of a desk with a message    "Congratulations on your new job".    He 
hands you a piece of paper 
marked "Contract of Employment".    After you sign it    he suddenly turns into a devil with an appropriately 
evil laugh
 
Janitor
A janitor is dutifully plunging a toilet in a public restroom.    His partner appears and hands him a mop 
instead.    The janitor smiles ear
to ear.      Punchline: "Congratulations on your new job" or "Congratulations on your new promotio".
 
Mime Baby (congratulations on a new baby)
A cute mime climbs down an imaginary rope into an infants bedroom.    He rocks an imaginary baby in his 
arms. A box then magically opens and out pops bottles, rattles and diapers.    The last diaper opens on screen 
with the verse,    "Words cannot express our happiness on your new arrival"

 Invitations
    
Pears
A number of cute pears run, jump, slide and just appear on screen.      You add your party invitation in the 
middle of the screen, for instance "Come to the New Year’s Party".    After the screen is filled with pears, a 
small plane flys by with a banner that reads "How’s that for Pear Pressure"
 
Robot
A cute CyberRobot walks on screen amidst a surrealistic 25th century background.    The robot drags a small 
machine to center stage.    He proceeds to enter a spaceship which blasts off the screen.    Then the small 
machine blasts off, expands to fill the screen and your 
invitation appears on the futuristic billboard.    
 



 



Upgrading your Barking Cards Lite
We hope you are enjoying Barking Cards Lite.        Blaze Technologies is constantly creating warm and wacky 
animated greeting card products.    You can call us at any time at (415) 691-9450 or visit our web site at 
http://www.barkingcard.com to see what other products or freebies are available.    

Our flagship product, Barking Cards 96, is currently available.    It includes a total of 25 animated cards (click here 
for a full description of the cards),    with greetings in the following categories:

Birthdays
Holidays
Invitations
Thank You
Congratulations (new job)
Romance./Friendship    

To purchase a product, contact us using one of the methods listed at the bottom of this order form (you can print this 
order form for use via mail or fax).      We accept money orders, checks, VISA, Mastercard, American Express and 
Discover.    

YOUR NAME:_________________________________________________________
(PLEASE PRINT)      First Name,    Middle Initial,    Last name

Title ________________________________________________________________

Company ____________________________________________________________ 

Address________________________________    Phone: (______) ______-________

          __________________________________________________________________

          __________________________________________________________________

City:______________________________ State/Prov:_________ Zip:_____________

-------------------------------------------------------------QTY----PRICE-----TOTAL---

Barking Cards 96 CD-ROM                                    ___        $29.95        $_________
 
Shipping and Handling         ___        $4.95          $_________
      
Sales Tax: (8.25% for CA Residents only)                                                $_________
                                                                          

__VISA __MasterCard __Check Enclosed                                    TOTAL $_________

__American Express    __ Discover

Credit Card Number:

________/________/________/________ Exp:____/____

Sign:X____________________________________



SEND THE BARKING CARDS 96 CD-ROM TO:

___ Address listed above.

___ Another address:    ____________________________________________
 
            ____________________________________________

 
                ____________________________________________

            ____________________________________________

          

                  ORDERS VIA MAIL                                CREDIT CARD ORDERS VIA FAX,  SECURE ONLINE 
ORDERS
        Enclose check and mail to:             EMAIL    OR PHONE

http://www.barkingcard.com
                  Blaze Technologies (415) 691-9450 Phone
                  181-19 Centre Street     (415) 938-1230 Fax
                Mountain View, CA                                              Sales@barkingcard.com
                                      94041                    



Starting Barking Cards Lite
To begin working with Barking Cards Lite, 

1. Click on the Windows 95 Start menu
2. Click on the Programs menu
3. Click on the Barking Cards Lite menu item

4. Click on the Barking Cards Lite Icon  

If you did not install Barking Cards Lite in the default folder during    the installation program, you will need 
to navigate from the Start menu to the folder in which you installed the program and then click the Barking 
Cards Lite Icon.



Exiting the Program
To exit the program, 
1. Click on the Exit option at the bottom of the File menu.



The Card Creation Process
Barking Cards Lite was designed to make it a simple process to make and send personalized, animated 
greeting cards.    Use our step by step wizard interface to easily create and modify greetings.    Use the 
<NEXT> key to move forward in the process and the <Back> key so step backward. 

 When you're in the final step of the process, simply hit <DONE> and the card will be compressed with the 
card player into a file that can be sent via diskette or e-mail to the receiver.    (The best part is that the whole 
process of creating a card can take less than 5 minutes. )



Starting Work on a Card
When Barking Cards Lite is started, a screen will appear giving you the option of creating a New Card from 
scratch (ie choosing one of our predesigned templates) or working on an existing card (a card you've already 
created).    
 
Selecting the New Card option will take you through a series of screens.    The first screen displays a variety 
of cards from which you can choose.

To start a New Card,
1. Click on the New Card button.

Selecting the Existing card option will take you directly to the Main Editing Window where you can modify 
or add text, images or sounds.    You can use this option to finish a card you've previously begun or to use an 
existing card as a basis for a new card that you'd like to send. 

To work on an Existing Card,
1. Click on the Existing Card button.



Choosing the Card Type 
The Lite versions generally includes 1-2 cards in 1 or more categories.      

To choose a card type, 

1. Double click on the picture of the card type you want.    Or alternatively, you can highlight a card 
type, either by single clicking on its picture or pressing the <TAB> key until you highlight it and hit 
<ENTER>. Then hit the <NEXT> button. 



Selecting the Card and Verse
Barking Cards Lite allows you to choose from 1-2 cards generally with a variety of verses.    You can use one 
of our funny messages or make one of your own. 

        
Previewing Cards
To sample all the cards click on each card in the Card Box.      This will change the snapshots at the top of the 
screen.    To see the complete animated card, click on the Play Card button. 

Verses
Each animated card has a number of different verses that are available for it, allowing you to fine tune the 
message for the receiver.      The verses can also be modified or created from scratch.      For instance, you 
could personalize the card by adding "Bill" or "Dad" to the verse itself.    This type of modification is the next
step in the process and is done in the Main Editing Window.    To view the verses, just click on them in the 
Verse Box. 

Most cards will also have a final scene that you can personalize by adding a message with your name, adding
images or pictures or even adding a recording.    This scene is like the inside of a standard printed greeting 
card.    It can also be modified in the Main Editing Window. 

Selecting Your Card
Once you've decided which card you'd like to send, 

1. Click on the card and verse in the Card and Verse Boxes.    You can check that you've highlighted the 
correct card by ensuring the snapshot of the card and verse are displayed at the top of the screen.

2. Click on the <NEXT> button. This will take you to the Main Editing Window. 



Building Your Greeting
Once you've picked an animated card and verse, you can start personalizing your greeting in the Main 
Editing Window.    You can:

· Modify the card verses
· Add your own personal message
· Add clip art or pictures
· Record a voice message
· Add a pre-recorded sound file
· Preview your customized card
· Create the final, sendable card

The Main Editing Window is designed to offer an simple interface for adding your own personal touch to 
your cards.    And this is the final step in the card creation process.

                                                                            
The key tools of the Main Editing Window work as follows:

  Previous Scene and Next Scene arrows - navigate to the different scenes in the
card.
 

                         Play button - plays the entire animated card, including all your 
personalizations.        

                           Cancel button - cancels the card you're working on.    It will first ask 
you, however, if    you'd like to save your changes.    

                             Done button -    creates the final sendable file that you can save to a 
diskette or save to your hard disk and attach to an e-mail for distribution.

 

                           Add Text button - adds a text field

                           Add Image button - adds clip art, pictures or connects to your scanner 
to import images

                           Add Sound button - adds pre-recorded sounds or allows you to record 
a message on the spot.

  

· Toolbar - offers easy access to common tasks (cut, copy, save, print, bold, italics).    If you pause the 
cursor above a toolbar option, a description of the option will appear.



Modifying Text 
The text in your cards will be either the verses that you chose in the Card Selection screen or text that you'll 
add.    Any text can be modified or personalized in the Main Editing Window.    Cards with verses that include
personal information about the receiver (like their first name or favorite hobby) will be much more fun for 
the recipient. 

To change text,

1. Double click on the text that you want to change.



Adding Text
As mentioned earlier, new text can also be added to your card in the Main Editing Window.      The most 
common area to add text (or images or sound for that matter) is on the final scene of the card.    This scene is 
designed to be similar to the inside of a standard printed greeting card.    Here you might add a personal 
message and your name.

Adding text to an animation scene
The text on an animation scene is automatically timed to fit in a text frame or word bubble in that scene.      
You can change or add text on most animation scenes that have a predefined place for text.    But note that the
text will only appear on screen for the period of time that the text frame or word bubble is on screen.    And 
you should try to add or change text so that it fits in the text frame or word bubble designed for that purpose 
(otherwise it won't look right).

To add text to your card,

1. Move to the scene where you want to add the text.    To move you can click on the Next Scene or 
Previous Scene arrows or use the Next Scene/Previous Scene options on the View menu.

2. Click on the Add Text button.        A text box will then appear in the middle of the screen.
3. Type in your desired message.
4. Click on any area outside the text box to end the text add.

Note:    If you add a large amount of text, you made neeed to resize the text box in ordre to display all of your
text. 



Adding Images
Much like slipping some pictures of your family inside a greeting card, you can add pictures, images or clip 
art to your card to further personalize it.    Images that you already have on your hard disk or a diskette can be
added. 

To add an image to your card,

1. Move to the scene where you want to add the image.    
2. Click on the Add Image button.    
3. Click the Browse button.    This will open a standard Windows 95 File Open screen.    
4. Find the desired image and double click on it.    A preview of the image will be displayed.
5. Click OK to add the image to your card.    Or repeat steps 3-5 to find another image.



Adding Sounds
Recording a personal message as part of your card can mean the difference between a card destined for the 
recycle bin and a card that is treasured forever.    In Barking Cards Lite, it is easy to either record a message 
or add a prerecorded message, song or sound to your multimedia card.    Technical Note: Barking Cards can 
play WAV files but cannot play MIDI files.

To record a message,      

1. Move to the scene where you want to add the sound.    This will generally be the final scene of the 
card.    

2. Click on the Add Sound button.  The Add Sound screen will then appear.
3. Click the Record button.  The Record screen will appear.
4. Click on the record button.    When you are finished click on the Stop button.    You can then play 

the message by hitting the Play button or rerecord it by hitting the Record button again
5. When you are satisfied with the message click on the OK button.    

                                                                A sound icon will appear in the Main Editing Window to indicate that you 
added a sound.                 

 Note: This icon itself will not be seen as part of the card.

To add an existing sound to your card,

1. Move to the scene where you want to add the sound.    
2. Click on the Add Sound button.    The Add Sound screen above will be displayed. 
3. Click the Browse button.    This will open a standard Windows 95 File Open screen.    
4. Find the desired sound and double click on it.    You can then hit the Play button to ensure that it is the

correct sound. 
5. Click OK to add the sound to your card or repeat steps 3-5 to find another sound.

Note: You can't add sounds to the animation scenes and you can only add one sound per scene to the final scenes of 
the card.    



Saving your Card
There are two ways to save a Barking Card and if you're ready to send it you should save it both ways.    
Otherwise you probably want to just use the standard Save option.

1) Saving (or saving without the player) - this saves the card so that it can be opened and changed in the 
future.    It does not save it with the animation player so it should not be sent to another person (because 
they won't be able to view it without the player).    This option saves the card as a BRK file.    This option can

be chosen as Save on the File menu or by clicking on the Save icon  on the    toolbar. 

2) Saving with the player for sending -    the saves the card with the animation player so that it can be sent and 
played by the recipient.    The animation player runs the graphics, sound and text and without it the receiver will not 
be able to view your card.      Saving with the player alone will not allow you to make additional changes to the card 
in the future.    This option can be chosen as

Save w/ Player for sending on the File menu.

If you're done working on or editing a card, the easiest way to save it is to 

1. Click on the Done button.        If you haven't added a personal message to your greeting, you will be 
reminded that you should.

2. Choose Yes to save your greeting.    
3. Choose Save as Both on the next screen.    This will save your card in a sendable form (with the player)

and also in a form that it can be reopened and edited (without the player).      
4. When the two save screens appear, choose a name for the file (like DADBDAY) and a location to 

save it.    The sendable file will automatically be given an .EXE extension meaning it is a program.    You
can save it to diskette or to your hard disk.    If you plan to send it as an attachment to an e-mail message 
from your computer you should save it to your hard disk.    Make note of where you saved it so that you 
can find it later when you want to send it via email.

When these steps are completed you will be taken back to the Card Type selection screen so you can begin 
making another card.

 

 



Creating the Send File
The Save w/ Player for Sending option on the File menu combines the animation, sound, text and images 
together with a card player into a file.    This file is then compressed to make it as small as possible so that it 
can be easily sent over e-mail.    The card can be played by any Windows 3.1 or Windows 95 user meeting the
minimum system requirements.      Cards cannot be played on Macintosh or Unix computers at this time.    
The card player is also included in this file meaning that the receiver will always have everything they need 
to view the card.

To create the auto-playing file, 

1. Choose the Save w/ Player for Sending option on the File menu.        The card files will then be 
compressed which will generally take a few minutes.        A Save screen will then appear. 

2. Choose a name for the file (like DADBDAY) and a location to save it.    The file will automatically be
given an .EXE extension meaning it is a program.    You can save it to diskette or to your hard disk    (see 
delivery methods).    If you plan to send it as an attachment to an e-mail message from your computer 
you should save it to your hard disk and make note of where you saved it.

Another alternative to creating an auto-playing card is to,

1. Click on the Done button.        If you haven't added a personal message to your greeting, you will be 
reminded that you should.

2. Choose Yes to save your greeting.    
3. Choose Save as Both on the next screen.    This will save your card in a sendable form and also in a 

form that it can be reopened and edited.      
4. When the two save screens appear, choose a name for the file (like DADBDAY) and a location to 

save it.    The sendable file will automatically be given an .EXE extension meaning it is a program.    You
can save it to diskette or to your hard disk.(see delivery methods)    If you plan to send it as an 
attachment to an e-mail message from your computer you should save it to your hard disk.    Make note 
of where you saved it so that you can find it later when you want to send it via email.

 



Sending Instructions
Barking Cards Lite was designed with the notion that most people will prefer to send their cards over e-mail 
(rather than by diskette).    You can actually send them either way but e-mail can be quicker and more 
convenient.    

To be suitable for e-mail distribution, our cards and software were created so that an average card will be 
about 400K - 600K in size.    This means that it will take about 3 - 5 minutes to send over a 28.8 baud 
modem.    Also check our tips for sending via email for additional information.

When the receiver gets your card, they will need this brief list of instructions in order to play the card, 

1. Copy or download the attached CARD.EXE file to a directory on your hard drive (substitute the 
name of the card you created for the name CARD.EXE)

2. In Windows 3.1:      From the Program Manager, 
· Go to Run option on the File menu.
· Enter the name and location of the CARD.EXE file (i.e. c:\download\Card.exe).
·  Press the OK button
·  Follow the on screen instructions to decompress and play the card.

OR

3. In Windows 95:    From the Start Menu, 
· Go to Run option
· Enter the name and location of the CARD.EXE file (i.e. c:\download\Card.exe).
·  Press the OK button

As an aid in e-mailing, we've included this list of receiving instructions which you can easily copy from 
either the INSTRUCT.TXT in the directory where you installed Barking Cards Lite and under the Sending 
Instructions in the Barking Cards Lite online help file.    You can go to either of these sources and copy and 
paste the instructions to your e-mail message.

To send it via e-mail,

1. Copy the receiving instructions to the clipboard from one of the sources mentioned above.    Or 
optionally just type your own from the section above.

2. Launch your e-mail software.
3. Compose the body of your message including the receiving instructions.
4. Add the CARD.EXE file as an attachment to the message.
5. Send the message.

You should expect to get an excited reply from the recipient when they receive and play your card.



Tips for Sending Cards via E-mail

Important Background
Barking Cards (and all electronic cards for that matter) are called "binary files".    They differ from standard 
e-mail files (or text files) because the include animation, images and sounds.    E-mail systems were first 
designed to send text files and not binary files.    This is important to know because you may encounter e-mail
systems that cannot send or receive binary files.

Sending Cards through Online Services
If you are a member of an online service (America Online,    CompuServe, Prodigy, Microsoft Network), 
using their e-mail capabilities can be a convenient way to send your cards to friends and family.    If the 
recipient is also a member of the same online service, sending    the card through that online services` mail is 
almost foolproof.      

If the recipient is not on the same online account, however, you could run into difficulties sending the binary 
file.      While all the major online services mentioned above allow you to send binary files to other members 
of their service, they don't all allow you to exchange binary files with recipients outside of their service.    If 
you find that your service does not seem to allow you to attach and send your card to other services you 
should contact them and make sure you have the latest version of their software.    If you do, then we 
recommend that you send the card via diskette instead.

Sending Cards over the Internet
Like online services, some Internet access providers will allow you to send and receive electronic cards and 
some won't.      Again, if you find that your provider does not allow you to attach and send your cards to its e-
mail system you should contact them and make sure you have the latest version of their software.    If you do 
have the latest software, then we recommend that you send the card via diskette instead.

Sending Cards at Work
Most businesses will have e-mail systems that accommodate sending files as attachments (Microsoft Mail, 
cc:mail and Lotus Notes all do).    So you should not have much difficulty sending your cards to colleagues in
your office.    But you may face the same challenge in sending outside of your company.    If this is the case, 
then we recommend using a diskette to send the card.



Contact Information

If you need to contact us or just want to learn more about our products here is a list of ways to reach Blaze 
Technologies:

Internet:
http://www.barkingcard.com

Email:
Sales@barkingcard.com
Support@barkingcard.com

Mail: 
Blaze Technologies, Inc.
181-19 Centre Street
Mountain View, CA 94041

Phone:
(415) 691-9450

Fax:
(415) 938-1230
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